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Short Description

Download 8495362 Excel Formulas Examples...



Description


☫ Learn MS-Excel With Easy Steps This Assignment is made for Professional Students.







This is a comprehensive and easy to learn assignment to learning the MS-Excel. This assignment provides you essential know-how for developing business Spreadsheets, Charts, Pivot Tables, Logical Calculations and many other things in MS-Excel. In this assignment I am introducing you to the wide variety of topics, I structured the assignment so that you learn MS-Excel in a carefully designed and step-by-step pictorial way. You understand at least the fundamental concepts of how MS-Excel works and Advance features of MS-Excel with easy help. Finally, I would like to say that I made this assignment easy for every person, and enabled the user to improve the style of Spreadsheets.



Sir Nadeem Shah IT Division ICMAP.



E-mail: [email protected]



☎ Phone: 9 243 900 . Ext . 237 (C omput er L ab) Mobi le: 0320- 5085330







the MS-Excel. business y other things in



s, I structured the d step-by-step how p.



ery person, and



SUM, AVERAGE, MAX, MIN, AND SIMPLE "IF" CONDITION.



S# 1 2 3 4 5 6 7



Name Zahid Akber Nida Moon Noor Faisal Benson



Test1



Test2 35 56 12 56 26 53 65



Test3 24 78 13 76 75 56 67



65



Total 24 45 23 34 87 78 89



13



Calculate Total, Average, Maximum, Minimum and Remarks by using Excel Functions. If you feel problem to solve see the help that is given below.



HELP WITH INSTRUCTIONS 1 Calculate Total 2 Calculate AVERAGE



=SUM(FIRST RANGE:LAST RANGE) =AVERAGE(FIRSTRANGE:LASTRANGE)



3 Calculate Maximum Value of Test1 and Minimum Value of Test2



=MAX(FIRSTRANGE:LASTRANGE) =MIN(FIRSTRANGE:LASTRANGE) 4 Calculate Remarks using IF Condition



Parts of If Condition



IF(Logic,"True Value","False Value") Tips



Total > 100 , " Good" Total < 100 , "Poor"



Solution Type in Cell C10 =MAX(C3:C9) Type in Cell D10 =MIN(D3:D9) Type in Cell G3 and Copy the formula =AVERAGE(C3:E3) Type in Cell H3 and Copy the formula =IF(F3>100,"GOOD","POOR")



AVG



Marks Sheet Remarks



WHAT IS THIS?



AutoSum In Microsoft Excel, adds numbers automatically with the SUM function. Microsoft Excel suggests the range of cells to be added. If the suggested range is incorrect, drag through the range you want, and then press ENTER. In Word, inserts an = (Formula) field that calculates and displays the sum of the values in table cells above or to the left of the cell containing the insertion point. Average Returns the average (arithmetic mean) of the arguments. Max Returns the largest value in a set of values. Min Returns the smallest number in a set of values. IF Condition Returns one value if a condition you specify evaluates to TRUE and another value if it evaluates to FALSE. Use IF to conduct conditional tests on values and formulas. Syntax IF(logical_test,value_if_true,value_if_fal se)



GRADE SHEET



Nested "IF" Conditions. Student Name Sana Khan M. Ali Kamran Saeed Nadia Barlas Nadeem Syed Arif Mustafa David Furqan Haider M. Ali Majid Bilal



Roll# 101 102 103 104 105 106 107 108 109 110



Test1 45 23 34 94 23 36 38 56 88 12



Test2 67 76 67 89 56 78 47 67 89 14



Test3 87 68 78 79 74 83 46 78 99 34



Test4 86 54 75 90 33 93 59 87 98 14



Test5 TOTAL Marks Obtained 35 500 76 500 82 500 88 500 67 500 77 500 34 500 45 500 89 500 24 500



Per%



Remarks



HELP WITH INSTRUCTIONS 1 Calculate Marks Obtain, 2 Calculate Per% 3 Calculate Remarks Using Nested IF Condition This time you are watching a Nested IF Condition in which you can add more than one IF Simultaneously.



IF(Per%>=80,"EXLT",IF(Per%>=70,"V.GOOD",IF(Per%>=60,"GOOD","BAD"))) 4 Calculate Grade Using Nested IF Condition



IF(Per%>=80,"A+",IF(Per%>=70,"A",IF(Per%>=60,"B","FAIL")))



Soluttion Type in Cell I3



=SUM(C3:G3)



Type in Cell J3 =I3/H3*100 Type in Cell K3 =IF(J3>=80,"EXLT",IF(J3>=70,"V.GOOD",IF(J3>=60,"GOOD","BAD"))) Type in Cell L3 =IF(J3>=80,"A1",IF(J3>=70,"A",IF(J3>=60,"B","FAIL")))



Grade



WHAT IS THIS? Nested IF Condition: Up to seven IF functions can be nested as value_if_true and value_if_false arguments to construct more elaborate tests. An Example of Nested "IF" Condition



=IF(PER>=80,"A+",IF(PER>=70,"A",IF(PER>=60,"B","FAIL")))



SALES REPORT OF COCA COLA BEVERAGE Employee Code 101 102 103 104 105



NAME



BASIC



NOMAN QADIR ARIF ZAHID BABAR



SALE1



2500 2000 2200 2500 2400



SALE2



900 150 100 450 150



800 250 300 250 100



SALE3



250 900 500 400 400



HELP WITH INSTRUCTIONS 1 2



Calculate Tot.Sale Calculate Allowance1 Using Nested IF Condition IF(Tot.Sale>=1000,Basic*35%,IF(Tot.Sale>=800,Basic*25%,"Try Again"))



3



Calculate Allowance2 Using IF(OR) Condition IF(OR(Tot.Sale>800,Basic=2500),1000,500)



4



Calculate Allowance3 Using IF(AND) Condition IF(AND(Tot.Sale>800,Basic=2500),1000,500)



Solution Type in Cell G3



=SUM(D3:F3)



Type in Cell H3



=IF(G3>=1000,C3*35%,IF(G3>=800,C3*25,"TRY AGAIN"))



Type in Cell I3



=IF(OR(G3>800,C3=2500),1000,500)



Type in Cell J3



=IF(AND(G3>800,C3=2500)1000,500)



STRUCTIONS



ted IF Condition



(Tot.Sale>=800,Basic*25%,"Try Again"))



R) Condition



ND) Condition



0),1000,500)



IF(AND), IF(OR) .



ALLOWANCE3



ALLOWANCE2



TOT.SALE



ALLOWANCE1



A COLA BEVERAGE



WHAT IS THIS? IF(OR( Returns TRUE if any argument is TRUE; returns FALSE if all arguments are FALSE. Syntax IF(OR(logical1,logical2,...),"True","False")



IF(AND( Returns TRUE if all arguments are TRUE; returns FALSE if any argument is FALSE. Syntax IF(AND(logical1,logical2,...),"True",'False")



Month JAN JAN JAN FEB FEB MARCH MARCH



SalesPerson Smith Gibbs Henery John Alen Disoza Smith



Qtr1 0 6 7 4 1 9



Qtr2 8 9



Qtr3 9 4



3 6 0 8



2 4 7 6



Total Sale



Solution R1 R2 R3 R4 R5 R6 R7 R8 R9



=IF(MAX(C2:E2)>7,"OK","NOT") =IF(MIN(C2:E2)15,"OK","NOT") =IF(COUNT(C2:E2)=3,"Y","N") =IF(COUNTIF(C2:E2,">5")>1,"Y","N") =IF(SUMIF(C2:E2,">5")>15,"Y","N") =IF(AVERAGE(C2:E2)>5,"Y","N") =IF(B2="Smith",SUM(C2:E2),"NOT") =IF(OR(B2="Smith",B2="John"),SUM(C2:E2),"NOT")



R1



R2



R3



R4 R5 R6 R7



Sm.Total



Sm. & Joh. Total



NEW WITH AMAZING



*R = Remarks *Sm = Smith *Joh = John



"IF"



In this Assignment you are getting some new techniques to use "IF" Condition. Enjoy it…………….



me new



Grade Book



VLOOKUP FUNCTION Student Name



Haider Ali Babar Zahid Faisal Ameen Rasool Qadir Yahya Alia



ID#



Test1



Test2



Test3



Test4



Test5



Total



6



67



56



89



68



80



500



3



56



57



78



46



47



500



4



78



89



88



90



87



500



1



98



99



91



95



90



500



7



34



23



22



12



67



500



2



67



78



89



67



97



500



5



24



34



34



23



34



500



8



67



84



66



77



86



500



9



23



46



57



87



90



500



10



45



67



45



78



88



500



Grading Criteria Table_Array is the complete table of information



0 40 50 60 70 80



FAIL D C B A A+



Col_Index is the Column# of Table_Array



Solution With Instructions STEP# 1 First you have to Calculate Per% by using this formula in Cell# J4 =I4/H4*100 Marks Obtain Divided by Total Marks Multiply by100 STEP# 2 After Calculating Per% we can Find out the Grades by using VLOOKUP Worksheet Function =VLOOKUP(J4,$E$16:$F$21,2) Type this formula in Cell# K4



J4 is lookup value $E$16:$F$21 Range of table_array 2 is Col_Index# of Table_Array



Lookup_Value M. Obtain



Per%



Grade



WHAT IS THIS Vlookup Searches for a value in the leftmost column of a table, and then returns a value in the same row from a column you specify in the table. Use VLOOKUP instead of HLOOKUP when your comparison values are located in a column to the left of the data you want to find.



Syntax



VLOOKUP(lookup_value,table_array,col_index_num) Lookup_value is the value to be found in the first column of the array. Lookup_value can be a value, a reference, or a text string. Table_array is the table of information in which data is looked up. Use a reference to a range or a range name, such as Database or List. Col_index_num is the column number in table_array from which the matching value must be returned.



Col_Index is the Column# of Table_Array



ons



Worksheet Function



returns a value in the same row from a OKUP when your comparison values are



dex_num)



e array. Lookup_value can be a value, a



up. Use a reference to a range or a range



ch the matching value must be returned.



SORTING AND FILTER NAME C F C A B B Q A Y A A A Z A N B D B B



Q1 Q2



BASIC SALE1 5000 45 3400 56 3000 56 3000 123 2200 145 2400 150 2000 150 2300 230 4000 240 3400 340 4000 356 5000 367 2500 450 2200 100 2500 200 5600 456 3500 365 6000 245 7000 346



SALE2 67 67 78 45 234 100 250 56 200 56 67 78 250 300 300 345 456 666 890



SALE3 TOT.SALE 678 89 89 67 50 400 400 345 124 360 89 98 400 500 250 67 345 78 456



STEPS FOR SORTING Select the above sheet from Cell# A2:F21 Go into Data Menu and select Sort command You will see a Sorting Window now select Ascending or Descending order and select the Column# by using sort by option and then by option.



STEPS FOR FILTERS STEP# 1 STEP# 2



SORTING



Sort Command is u rows or lists Alphab order or Descendin 100 TO 1, 1-1-1998 DATA>SORT



FILTER



The quickest way to in a list. DATA>FILTER>AU



Sort Sheet in Ascending Order (Sort by Name in Ascending Order and then by Basic Desce Filter The Records (Basic >3000 and Total Sale Auto Filter Command You will see the drop down buttons with every field You can use these buttons to Filter your data



WHAT IS THIS? SORTING Sort Command is used to arrange tha Information in selected rows or lists Alphabetically, Numerically or by date in Ascending order or Descending order. A TO Z or Z TO A, 1 TO 100……or 100 TO 1, 1-1-1998…..to….30-12-2002 DATA>SORT



FILTER The quickest way to select only those items you want to display in a list. DATA>FILTER>AUTO FILTER



d then by Basic Descending Order)



CHARTS SHEET 1



Pakistan VS Australia 1st Match



2nd Match 3rd Match 4th Match Pakistan 234 301 298 156 Australia 235 256 289 158 Method 1 Create a Column Chart of SHEET1 Select Sheet # 1 from A4 TO F6, Press F11 Function Key the Quick Chart Will be created on a new sheet.



SHEET2 NAME TOTAL SALE SHAH 10000 ALI 8900 KAMAL 3450 SONIA 6789 SANA 12345 ZIA 13456 YASEEN 10988 QAMAR 6789 ALAM 45677 Method 2 Create a Pie Chart of SHEET 2 Select Sheet # 2 from A14 TO B23, Click on Chart Wizard Icon and follow all instructions.



5th Match



d on a new sheet.



213 214



WHAT IS THIS? About Charts



Charts are visually appealing and make it easy for users to see comparisons, patterns, and trends in data. For instance, rather than having to analyze several columns of worksheet numbers, you can see at a glance whether scores are falling or rising , or how the Pakistan's score compare to the Australian score. You can create a chart on its own sheet or as an embedded object on a worksheet. You can also publish a chart on a Web page. To create a chart, you must first enter the data for the chart on the worksheet. Then select that data and use the Chart Wizard to step through the process of choosing the chart type and the various chart options. A chart is linked to the worksheet data it's created from and is updated automatically when you change the worksheet data.



Create a Chart



Select the cells that contain the data that you want to appear in the chart. Click Chart Wizard Button or go into the Insert menu and select Chart Command than follow the all instructions carefully.



IMPORTANT



You can make a quick chart by pressing F11 key, it will be a Column Chart but you can change the Type by using Chart Wizard Toolbar.



Created by Nadeem Shah Computer Division ICMAP



COUNT FUNCTION



Name Test1 Test2 Test3 Zahid Nill Nill 89 Akber 56 78 45 Nida 99 13 23 Moon 56 99 99 Noor 26 99 87 Faisal 89 99 78 Benson Nill 67 89



Solution Type in Cell B10 Type in Cell C10 Type in Cell D10



=COUNT(B3:B9) =COUNT(C3:C9) =COUNT(D3:D9)



Counts the Cells that contains Numbers



SEE ALSO THE COUNT BLANK What is This?



COUNTBLANK Counts empty cells in a sp Graphics 4



5 6 9



Type Here



=COUNTBLANK(A18:A24)



7 8 2



Syntax COUNTBLANK(range)



Range is the range from w the blank cells.



Remarks Cells with formulas that ret also counted. Cells with ze counted.



The Answer will be 2, because there are 2 empty Cells in this range



Created by Na Computer Div



olution



WHAT IS THIS? =5 =6 =7



Count



Counts the number of cells that contain numbers and numbers within the list of arguments. Use COUNT to get the number of entries in a number field in a range or array of numbers. Syntax COUNT(value1,value2, ...)



What is This?



COUNTBLANK Counts empty cells in a specified range of cells. Syntax COUNTBLANK(range) Range is the range from which you want to count the blank cells. Remarks Cells with formulas that return "" (empty text) are also counted. Cells with zero values are not counted.



Created by Nadeem Shah Computer Division ICMAP



SumIf & CountIf Functions WHAT IS THIS Emp. Name Kashif Ali Noman Sidra Romana Nasir Faisal Nadeem Jalal Rufi Ayjaz Lilly



Basic 4000 3000 2500 6000 4000 7000 5000 4000 2500 5000 3000 6000



Bonus



SumIf Adds the cells specified by a given criteria. CountIf Counts the Cells specified by a given criteria. Syntax =SUMIF(range,"criteria") =COUNTIF(range,"criteria") Sum the Bonus that have value >2000 using Sumif Function.



Count the Bonus that have value >2000 using Sumif Function.



Solution Type in Cell C17 Type in Cell C18



=SUMIF(C5:C16,">2000") =COUNTIF(C5:C16,">2000")



Created by Nadeem Shah Computer Division ICMAP



ed by a given criteria. cified by a given criteria.



Solution



MIF(C5:C16,">2000") NTIF(C5:C16,">2000")



eated by Nadeem Shah mputer Division ICMAP



A 1 2 3 4 5 6 7



Cost of Computer Salvage Value Life



D



30000 5000 10



YEARLY DEPRECIATION Period in Years



Double Declining



Straight Line



Sum of Years Digit



1 2 3 4 5 6 7 8 9 10



Solution



22 23 24 25 26



C



DDB, SLN, SYD METHODS



8 9 10 11 12 13 14 15 16 17 18 19 20 21



B



Double Declining Straight Line Sum of Years Digit



Rs.6,000.00 =DDB($B$5,$B$6,$B$7,A11) Rs.2,500.00 =SLN($B$5,$B$6,$B$7) Rs.4,545.45 =SYD($B$5,$B$6,$B$7,A11)



E



F



G



H



1 2 3 4 5 6



WHAT IS THIS?



7



DDB(cost,salvage,life,period)



I



J



K



L



DDB Returns the depreciation of an asset for a specified period using the double-declining balance method . Syntax



8 9 10 11 12 13 14 15 16 17 18 19 20 21



SLN Returns the straight-line depreciation of an asset for one period. Syntax SLN(cost,salvage,life)



SYD Returns the sum-of-years' digits depreciation of an asset for a specified period. Syntax SYD(cost,salvage,life,period)



22 Solution 23 24 25 26



Type in Cell b11 Type in Cell C11 Type in Cell D11



Created by Nadeem Shah Computer Division ICMAP



M



PIVOT TABLE REPORT NAME ALI BABAR SAFDAR ZIA BILL ALI SILVESTER NOMAN BABAR YOUSUF AZIZ AKRAM ALI RAO MALIK AFSAR RAEES RASHEED ZIA



BASIC 5000 4000 3400 3000 2300 2200 7000 6000 5600 2400 2200 5000 3000 3500 3400 2500 2000 4000 2500



REGION EAST WEST EAST NORTH SOUTH EAST WEST SOUTH NORTH EAST WEST EAST EAST SOUTH NORTH WEST SOUTH EAST SOUTH



SALE1 SALE2 SALE3 367 78 98 356 67 89 340 56 360 135 45 67 230 56 345 100 300 500 346 890 456 245 666 78 456 345 67 150 100 400 145 234 50 45 67 678 56 78 89 365 456 345 56 67 89 200 300 250 150 250 400 240 200 124 450 250 400 Tips with Instructions



STEP# 1 STEP# 2 STEP# 3 STEP# 4 STEP# 5



STEP# 6 Page row data column



First select the above sheet from Cell A2 to G21 Go into Data Menu and select the command Pivot Table and Pivot Chart Report You will see the Pivot Table Wizard now Press the next button Again a small window appears and ask for Data Range that you have selected before, Press Next Now Wizard will ask you where do you want to put the Pivot Table Report On New Worksheet Existing Worksheet You will see that the New Worksheet Option is already selected you can change the option if you n Now Press the Layout Button You can see the Lay Out dialog box, in this box you can set fields for the Pivot Table You have four main areas and group of field buttons Page Row Data Column Column



Page



Row



Data



NAME BASIC REGION SALE1 SALE2



Row



Data SALE3 TOT.SALE



STEP#7



From the group of field button on the right, drag the fields that you want onto the ROW and Column in the diagram. To include a data field drag the field onto the DATA area. Note: Data area is a different summary function to calculate the numeric fields You should place all Numeric Data Fields in this area You can include more than one fields in this area When you are satisfied with the layout, press OK, and press Finish.



WHAT IS THIS?



TOT.SALE 543 512 756 247 631 900 1692 989 868 650 429 790 223 1166 212 750 800 564 1100



ions



and Pivot Chart Report



hat you have selected before, Press Next vot Table Report



elected you can change the option if you need



set fields for the Pivot Table



Pivot Table? A PivotTable report is an interactive table that you can use to quickly summarize large amounts of data. You can rotate its rows and columns to see different summaries of the source data, filter the data by displaying different pages, or display the details for areas of interest. When to use a Pivot Table Report Use a PivotTable report when you want to compare related totals, especially when you have a long list of figures to summarize and you want to compare several facts about each figure. Use PivotTable reports when you want Microsoft Excel to do the sorting, subtotaling, and totaling for you.



Created by Nadeem Shah Computer Division ICMAP



that you want onto the ROW and Column area



function to calculate the numeric fields ric Data Fields in this area an one fields in this area



Subtotals Person Name Faisal Rufi Nadeem Faisal Babar Nadeem Rufi Ayjaz Ayjaz Babar Nadeem Rufi Zubair Faisal Kashif Nadeem Rufi Ayjaz Nadeem Zubair



Type Ribbon Ribbon Dimm Scanner Printer Printer Printer TV TV TV TV VCR VCR Computer Computer Computer Computer Car Car Car



Unit Sold 4 9 10 2 1 5 5 4 3 1 6 4 2 3 5 7 6 1 2 1



Unit Price 300 300 500 3000 6000 6000 6000 10000 10000 10000 10000 12000 12000 50000 50000 50000 50000 200000 200000 200000



Tips with Instructions STEP# 1 STEP# 2 STEP# 3 STEP# 4 STEP# 5 STEP# 6



STEP# 7



Sort the list by the column for which you want to Calculate subtotals. Select data from A2 to E22 On the Data menu, click Subtotals. You will see a new window In the At each change in box, click the column that contains the group for which you want subtotals. In the Use function box, click the function you want to use to calculate the subtotals. In the Add subtotal to box, select the check boxes for the columns that contain the values for which you want to subtotals.



Total Price 1200 2700 5000 6000 6000 30000 30000 40000 30000 10000 60000 48000 24000 150000 250000 350000 300000 200000 400000 200000



WHAT IS THIS? Subtotal?



Microsoft Excel can automatica calculating subtotal and grand automatic subtotals, your list m and the list must be sorted on t want subtotals.



Figure for hel



WHAT IS THIS? Subtotal? Microsoft Excel can automatically summarize data by calculating subtotal and grand total values in a list. To use automatic subtotals, your list must contain labeled columns and the list must be sorted on the columns for which you want subtotals.



Figure for help



Created by Nadeem Shah Computer Division ICMAP



Conditional Formatting What is This? Conditional Formatting allows you to change the formatting applied to cell depending on the current value of the cell. This can make auditing large worksheets much faster by automatically highlighting exceptions. Conditional Formatting allows you to apply up to three separate conditions to a cell. Conditional Formatting allows you to change the font style, borders, and cell patterns.



Conditional Formatting Example #1 Cells H10:H14 contain three Conditional Formatting rules that will change the formatting of the cells depending on the values entered into the cells. To see the conditions applied to the cells, select cell H10, and then click Conditional Formatting on the Format menu.



4 7 text 1 15



Conditional Formatting Example #2 - Hiding Error Values This example illustrates how to use Conditional Formatting to hide error values that are returned by formulas. In this example, cells H21 and H23 would normally display the #DIV/0! error code. The Conditional Formatting that has been applied sets the font color of the cells containing an error value to match the background of the worksheet. To see the conditions applied to the cells, select cell H19, and then click Conditional Formatting on the Format menu.



2.5 4 #DIV/0! 5 #DIV/0!



10 20 30 40 50



4 5 8



Data Validation Data Validation allows you to set up restrictions for the values that can be entered into a cell. The following examples present several common scenarios for using Data Validation. Data Validation Example #1 - Restricting Entry to Numeric Values Cells H9:H13 have been formatted with a validation rule that restricts cell entries to numeric values. This example utilizes the Stop style for the Error alert, which prevents you from making an invalid entry into the selected cell. To see the Validation settings for this example, select cell H9, and then click Validation on the Data menu. Data Validation Example #2 - Restricting the Length of a Text Entry Cells H19:H23 have been formatted with a validation rule that restricts the length of text entries to seven characters or less. This example utilizes the Warning style for the Error alert, which gives you the option to cancel the current entry, or enter the invalid value into the selected cell. To see the Validation settings for this example, select cell H19, and then click Validation on the Data menu. Data Validation Example #3 - Restricting Entry to a Range of Whole Numbers Cells H30:H34 have been formatted with a validation rule that will alert you if you do not enter a whole number between 1 and 10. This example utilizes the Information style for the Error alert, which informs you of an invalid entry, but allows you to keep the current value. To see the Validation settings for this example, select cell H30, and then click Validation on the Data menu. Data Validation Example #4 - Restricting Cell Entry to a List of Values Cells H41:H45 have been formatted with a validation rule that restricts the entries to a list of values. The list of valid entries is contained in cells M41:M49. When you select a cell within the range H41:H45, a dropdown arrow appears on the cell. When you click the arrow, the list of valid entries is displayed. You can simply click the entry that you wish to make. This example utilizes the Stop style for the Error alert, which prevents you from making an invalid entry in the cell. To see the Validation settings for this example, select cell H41, and then click Validation on the Data menu.



WHAT IS THIS? DATA VALIDATION



Data Validation allows you to se can be entered into a cell. The several common scenarios for u



STEPS: 1. Go into Data Menu and sece



2. Set the Validation Criteria by



HAT IS THIS?



A VALIDATION



Validation allows you to set up restrictions for the values that be entered into a cell. The following examples present ral common scenarios for using Data Validation.



PS: o into Data Menu and secect the command "Validation"



et the Validation Criteria by using setting tab.



Bob Chris David John Mike Perry Randal Steve Tim



Graphics 9



Graphics 8



Graphics 7



Auditing Toolbars



Trace Precedents



Clear Validation Circles



Remove Precedents Arrows



Circle Invalid Data



Trace Dependents



New Comments



Remove Dependents Arrows Trace Precedents



Remove All Arrows



Instructions



EXAMPLES



Use of Precedents and Dependents ITEM LIST Keyboard Printer Joystick TOTAL 100 200 10000 1200 11500 20 20 5 10 55 2000 4000 50000 12000 68000 GRAND TOTAL



Mouse UNIT PRICE QUANTITY TOTAL PRICE



68000



Step1



Go into Tools Menu and place mouse pointer on Auditing Command and then click on Show Auditing Tool Bar



Step2



Now Place the Cell Pointer on Cell# F31, and then click on Trace Precedents Button One blue tracer arrow will be appeared.



Step3



Place the Cell Pointer on Cell# B33, and click on Trace Dependents Button Now two tracer arrows will be appeared.



Step4



If you want to remove all Tracing Arrows click on Remove All Arrows Button.



More About Auditing Trace Error Button



If the active cell contain an error value such as #VALUE, #NAME? or #DIV/0, draws tracer errows to the active cell from the cell that cause the error value.



2 3 4 5



Place the Cell Pointer on Cell and Click on Trace Error Button. One Tracer Arrow will show that the Cell# G66 is an Error Value.



Trace Error Button



If the active cell contain an error value such as #VALUE, #NAME? or #DIV/0, draws tracer errows to the active cell from the cell that cause the error value.



###



New Comments Button



Place the Cell Pointer on Cell and Click on Trace Error Button. One Tracer Arrow will show that the Cell# G66 is an Error Value. Place the Cell Pointer on Cell and click New Comment Button. Now type your own comments for active cell.



Inserts a comment at the insertion point.



Circle Invalid Data



Identifies all cells that contain values that are outside the limits you set by using the Validation command on the Data menu. To see what data restrictions and messages are in effect for a cell, set the Validation Rules on the Data and then click on the Circle Invalid Data Button.



7 3 4 5 8 6



Select cells from G61 to G66 then Go into Data Menu and select Validation Command and set Validation Rules: Allow only Whole Number > 5 and press ok. Now click on Circle Invalid Data Button, you will see three circles on No. 3, 4, 5, because these Nos. are invalid for this range.



WHAT IS THIS AUDITING Microsoft Excel provides tools that help you track down problems on your worksheets.



Clear Validation Circles



Circle Invalid Data



For example, the value you see in a cell may be the result of a formula, or it may be used by a formula that produces an incorrect result. The auditing commands graphically display, or trace, the relationships between cells and formulas with tracer arrows.



New Comments



Trace Precedents



EXAMPLES



n click on Show Auditing Tool Bar



ce the Cell Pointer on l and Click on Trace or Button. e Tracer Arrow will ow that the Cell# G66 is Error Value.



When you audit a worksheet, you can trace the precedents (the cells that provide data to a specific cell) or you can trace the dependents (the cells that depend on the value in a specific cell.



ce the Cell Pointer on l and Click on Trace or Button. e Tracer Arrow will ow that the Cell# G66 is Error Value.



ace the Cell Pointer on ll and click New mment Button. Now e your own comments active cell.



ect cells from G61 to G66 n Go into Data Menu and ect Validation Command and Validation Rules:



ow only Whole Number > 5 d press ok.



w click on Circle Invalid Data ton, you will see three circles No. 3, 4, 5, because these s. are invalid for this range.



LOOKUP S. Nos



NAME 1 SAEED 2 RAHIL 3 ZAHID ALI 4 NOMAN BABAR 5 ASIF KHAN



F. NAME ALI SHAH KHAN NOOR ZAMAN QADIR BHAI RAFI ULLAH



T. PHONE ADDRESS 3444455 KARACHI 8978766 LAHORE 6767676 KARACHI 7878888 PINDI 6676777 HYDERABAD



5



FORMULAS USED



NAME



Err:504



 =LOOKUP(B10,$A$2:$F$7,$B$2:$B$7)



F. NAME



Err:504



 =LOOKUP(B10,$A$2:$F$7,$C$2:$C$7)



T. PHONE



Err:504



 =LOOKUP(B10,$A$2:$F$7,$D$2:$D$7)



ADDRESS



Err:504



 =LOOKUP(B10,$A$2:$F$7,$E$2:$E$7)



MARRIED



Err:504



 =LOOKUP(B10,$A$2:$F$7,$F$2:$F$7)



Type any S. No



MARRIED Y Y N Y N



USED



$7,$B$2:$B$7)



$7,$C$2:$C$7)



$7,$D$2:$D$7)



$7,$E$2:$E$7)



$7,$F$2:$F$7)



WHAT IS THIS? Lookup Returns a value either from a one-row or one-column range or from an array. The LOOKUP function has two syntax forms: vector and array. The vector form of LOOKUP looks in a one-row or onecolumn range (known as a vector) for a value and returns a value from the same position in a second one-row or onecolumn range. The array form of LOOKUP looks in the first row or column of an array for the specified value and returns a value from the same position in the last row or column of the array.



BIG PAYROLL SHEET EMP NAME A B C D E F G H I J K L



TOTAL:



BASIC Rs.25,000.00 Rs.25,000.00 Rs.15,000.00 Rs.10,000.00 Rs.10,000.00 Rs.6,000.00 Rs.4,000.00 Rs.15,000.00 Rs.10,000.00 Rs.10,000.00 Rs.6,000.00 Rs.4,000.00



140000



DESIGNATION DIRECTOR DIRECTOR ASSISTANT MANAGER OFFICER OFFICER TYPIST PEON ASSISTANT MANAGER OFFICER OFFICER TYPIST PEON D3 E3 F3 G3 H3 I3 J15 K3 L3 K15 L3 N3 O3



Instructions for FILTER



H_RENT 13,750.00 13,750.00 8,250.00 5,500.00 5,500.00 3,300.00 2,200.00 8,250.00 5,500.00 5,500.00 3,300.00 2,200.00



CONVEYANCE 3,750.00 3,750.00 2,250.00 1,500.00 1,500.00 900.00 600.00 2,250.00 1,500.00 1,500.00 900.00 600.00



77000



=55%*B3 =15%*B3



21000



SPECIAL ALL.#1 6,250.00 6,250.00 2,250.00 1,000.00 1,000.00 300.00 200.00 2,250.00 1,000.00 1,000.00 300.00 200.00



22000



T_ALL.S 23,750.00 23,750.00 12,750.00 8,000.00 8,000.00 4,500.00 3,000.00 12,750.00 8,000.00 8,000.00 4,500.00 3,000.00



SPECIAL ALL.#2



120000



I_TAX



5000 5000 3000 2000 2000 0 0 3000 2000 2000 0 0



28000



ALL.S_GT



3750 3750 750 200 200 200 200 750 200 200 200 200



21000



148000



A B



Max Basic = Min Basic= Average G_salary



BASIC



=IF(C3="DIRECTOR",25%*B3,IF(C3="MANAGER",20%*B3,IF(C3="ASSISTANT MANAGER",15%*B3,IF(C3="OFFICER",10%*B3,5%*B3))))



=D3+E3+F3 =IF(G3>5000,20%*B3,0) =IF(B3>20000,15%*B3,IF(B3>15000,10%*B3,IF(B3>10000,5%*B3,200))) =G15+H15 =B3+J3 =IF(C3="DIRECTOR",20%*K3,IF(C3="MANAGER",15%*K3,IF(C3="ASSISTANT MANAGER",10%*K3,IF(C3="OFFICER",5%*K3,200)))) =B15+J15 =IF(C3="DIRECTOR",20%*K3,IF(C3="MANAGER",15%*K3,IF(C3="ASSISTANT MANAGER",10%*K3,IF(C3="OFFICER",5%*K3,200)))) =IF(M3>500000,55%*B3,IF(M3>350000,40%*B3,IF(M3>200000,20%*B3,IF(AND(M30),10%*B3,0)))) =I3+L3+N3



DESIGNATION



H_RENT



Rs.25,000.00 DIRECTOR Rs.25,000.00 DIRECTOR



Max, Min, Average Rs25,000.00 =MAX(B3:B14) Rs4,000.00 =MIN(B3:B14) 23666.67 =AVERAGE(K3:K14)



D44=EMP-NAME AND E44=BASIC Cell Addresses Description



5000 5000 5000 5000 5000 5000 5000 5000 5000 5000 5000



EMP_NAME



23750 23750



SPECIAL ALL.#2



I_TAX



5000 5000



C



Rs.25,000.00



B



Rs.25,000.00



C



Rs.15,000.00



D



Rs.10,000.00



E



Rs.10,000.00



F



Rs.6,000.00



G



Rs.4,000.00



H



Rs.15,000.00



I



Rs.10,000.00



J



Rs.10,000.00



K



Rs.6,000.00



L



Rs.4,000.00



B



A



FG



H



I



J



L K



A B C D E F G H



I J K L



Calculate "VAR" and "Stdev" Name Score Amir Sohail 100 Inzemam 45 Afridi 56 Moeen Khan 78 =VAR(E69:E72) 594.92 =STDEV(E69:E72) 24.39



=IF(OR(I44="A",I44="B"),10000,5000)



I44=EMP_NAME Cell Address Description



If the value of I44 equals to "A" OR "B" then assign 10000 in H44 otherwise put 5000 in H44 



PF_DEDUCTION 10,750.00 10,750.00 3,075.00 1,000.00 1,000.00 200.00 200.00 3,075.00 1,000.00 1,000.00 200.00 200.00



HB_ADVANCE 650,000.00 600,000.00 500,000.00 400,000.00 425,000.00 350,000.00 300,000.00 250,000.00 200,000.00 225,000.00 150,000.00



32450



4050000



3750 3750



28750 28750



G_SALARY



53750 53750



PF_DEDUCTION



10750 10750



HB_ADVANCE



650000 600000



49900



28,250.00 28,250.00 9,825.00 5,200.00 5,200.00 1,600.00 1,200.00 6,825.00 2,200.00 3,200.00 400.00 800.00



92950



53750 30750 20000 20000 10500 7000 30750 20000 20000 10500 7000 G_SALARY 7000 10500 20000 20000 30750 7000 10500



E



20000



D



20000



C



30750



B



53750



A



53750



55000 50000



30000 25000



F G H I J K L



20000 15000 10000 5000 0



13750 13750



T_DEDUCTIONS



28250 28250



How to use this Assignment A B C D E



45000 40000 35000



HB_DEDUCTION



Note



PAYROLL



G_SALARY 53750



10000 B 5000 C 5000 D 5000 E 5000 F 5000 G 5000 H 5000 I 5000 J 5000 K 5000 L Sort the Chart Range EMP_NAME Data in descending order L Highlight all Data by Mouse K Go into Data Menu J Click Sort I Select Emp_Name in Sortby H Click Descending Button G and then Click OK F



T_DEDUCTIONS



=PMT(Rate, Number of Periods, Payment)



ALL.S_GT



Chart & IF Condition Range EMP_NAME



10000 A



HB_DEDUCTION 13,750.00 13,750.00 6,000.00 4,000.00 4,000.00 1,200.00 800.00 3,000.00 1,000.00 2,000.00 400.00



Use Sum IF Function Range is (K3:K14) Sum the Values >20000 in G_Salary Ans formula Rs.169,000.00 =SUMIF(K3:K14,">20000") Sum the Values 20000),10000,5000)



If the value of D44 equals to "A" AND E44 is greater then 20000 then assing 10000 in C44 otherwise put 5000 in C44 



13750 13750



CONVEYANCE



G_SALARY Rs.53,750.00 Rs.53,750.00 Rs.30,750.00 Rs.20,000.00 Rs.20,000.00 Rs.10,500.00 Rs.7,000.00 Rs.30,750.00 Rs.20,000.00 Rs.20,000.00 Rs.10,500.00 Rs.7,000.00



Calculate Present Value and Future Value Rate 10% Years 2 Deposits 1,000 Formulas PV= 1736 =PV(K18,K19,K20) FV= 2,100 =FV(K18,K19,K20) Calculate Payment(PMT) Rate 0.92% Month 300 Loan 100000 Fromula PMT= 983.01 =PMT(K24,K25,K26,) =PV(Rate, Number of Periods, Payment) =FV(Rate, Number of Periods, Payment)



Select All Data with Headings, Go into Data Menu, Click Filter, Select Auto Filter, Click DragDown Arrow of BASIC, Go into Custom and Select ">" type 20000 and Press OK. (RANGE IS A2:O14) Filter Records BASIC > 20000



EMP_NAME



28750 28750 15750 10000 10000 4500 3000 15750 10000 10000 4500 3000



G_SALARY



Make Chart Easily Select the Data with Mouse. Go into Insert Menu and click Chart or Click Chart Icon in Standard Toolbars. The Chart window appears. Select Chart Type than click on Next Button. Now Check your Chart Range. Click Next. Then Give the Chart Title and use other Chart options in Chart Wizard Window. Click Next. Select "As Object In" then click Finish. The Chart is Ready.



Open a worksheet Program Make a Database with the all fields as described above Fill the required fields then apply the different functions as explained in detail in this sheet. Refer to the correct cell Addresses in inserting formulas. If you feel any problem regarding this assignment please contact to Lab Staff. Created By Nadeem Shah Computer Lab ICMAP



IRR Returns the internal rate of return for a series of cash flows represented by the numbers in values. These cash flows do not have to be even, as they would be for an annuity. However, the cash flows must occur at regular intervals, such as monthly or annually. The internal rate of return is the interest rate received for an investment consisting of payments (negative values) and income (positive values) that occur at regular periods.



Examples Suppose you want to start a restaurant business. You estimate it will cost $70,000 to start the business and expect to net the following income in the first five years: $12,000, $15,000, $18,000, $21,000, and $26,000. B1:B6 contain the following values: $-70,000, $12,000, $15,000, $18,000, $21,000 and $26,000, respectively.



Solution Cost (Cost or Investment must be with (-) Minus Sign



1 2 3



Income of Year-1 Income of Year-2 Income of Year-3 Income of Year-4 Income of Year-5 To calculate the investment's internal rate of return after four years: =IRR(J6:J10) equals -2.12 percent To calculate the internal rate of return after five years: =IRR(J6:J11) equals 8.66 percent To calculate the internal rate of return after two years, you need to include a guess: =IRR(J6:J8,-10%) equals -44.35 percent



ers in values. These cash ws must occur at regular eceived for an investment egular periods.



start the business and $21,000, and $26,000. B1:B6 000, respectively. -70000



12000 15000 18000 21000 26000 -2% 9% -44%



Sales Person Name Baker Zambi Cethy Armor



Cost Each £0.35 £0.35 £0.35 £0.35



Item Sold 17 12 5 2



Mars Toffee crisp Galaxy Bounty



Maria Diana Maria Diana



£0.22 £0.22 £0.25 £0.22



35 27 7 4



Crisps



Monster munch Fries Discos Walkers



Steven Lilly Lilly Lilly



£0.22 £0.22 £0.22 £0.22



8 10 5 1



Drinks



Coke Lilt Sprite Fanta



John Morgan John Morgan



£0.35 £0.35 £0.35 £0.35



20 17 9 2



Sweets



Lollypops



George



£0.01



50



Sandwiches



Chocolates



Food Cheese & Tomato Tuna &Tomato Tomato & Cucumber Egg & Maranade



Maximum Value of Item Sold for Sandwiches Minimum Value of Item Sold for Chocolates Average of Item Sold for Drinks



Test Paper of MS-Excel Instructions (Read Carefully) Total Time (1/2 hr) Q1. Design the given sheet (5 pts) Q2. Calculate Total Cost (2 pt.)



Q2. Calculate Stocking by using "IF" Logical Function. Tips: [Item Sold is greater than 15, Print "Restock" otherwise Print " Q4. Calculate Bonus by using VLOOKUP Function. Tips: [The Rate Table is Given Below use this table and use Item Sold Q5. Calculate Maximum, Minimum and Average by using Excel Built-in Functions. (3 pts.) Q6. Filter the Sheet. Tips: [ Show only "Baker's" Records]. (3 pts.) Q7. Sort the Sheet. Tips: [Sort by "Sales Man Name" for Sendwiches in Ascending order]. (2 pts.)



Q1. Design the given sheet (5 pts) Q2. Calculate Total Cost (2 pt.)



Q2. Calculate Stocking by using "IF" Logical Function. Tips: [Item Sold is greater than 15, Print "Restock" otherwise Print " Q4. Calculate Bonus by using VLOOKUP Function. Tips: [The Rate Table is Given Below use this table and use Item Sold Q5. Calculate Maximum, Minimum and Average by using Excel Built-in Functions. (3 pts.) Q6. Filter the Sheet. Tips: [ Show only "Baker's" Records]. (3 pts.) Q7. Sort the Sheet. Tips: [Sort by "Sales Man Name" for Sendwiches in Ascending order]. (2 pts.)



Q8. Create a Pivote Table Report. Tips: [Use "Sales Man Name" and "Food" at Row area and "Total Cost" at Data area of P Q9. Create a Pie Chart. Tips: [ Use only "Food" and "Item Sold Field" for Crisps]. (2 pts.)



Q10. Apply Conditional Formatting on Column Stocking Tips: [ If the results is Restock the Font Color should be red other w should be Green]. (3 pts) Q11. Apply Validation Rules. Tips: [ Apply these rules on "Item Sold" Column, the Number > 30 should be Invalid otherwise Data by using Auditing Tool]. (5 pts).



Total Cost



Stocking



Bonus



Rate Table for Bonus Item Sod Bonus 0 kick out 5 £1.00 10 £2.00 15 £3.00 20 £4.00 25 £5.00 30 £10.00



nt "Restock" otherwise Print "Stock"] (2 pts.) this table and use Item Sold Field for Bonus] (4 pts)



pts.)



nt "Restock" otherwise Print "Stock"] (2 pts.) this table and use Item Sold Field for Bonus] (4 pts)



pts.) "Total Cost" at Data area of Pivot Table]. (4 pts.)



nt Color should be red other wise the Fount Color



0 should be Invalid otherwise Valid then Circle Invalid



1999 Computer Tour City Lahore Karachi Quetta Jan-Total



Date 23-Jan-99 25-Jan-99 27-Jan-99



Fee 10000 12000 14000



Attendance Computer Sold Performance 1000 167 1200 200 450 500



Islamabad Multan Hyderabad Feb-Total



5-Feb-99 7-Feb-99 9-Feb-99



13000 14000 11000



2300 300 1250



369 568 23



Sialkot Faisalabad Peshawar Mar-Total



12-Mar-99 14-Mar-99 15-Mar-99



12000 16000 13000



490 1600 200



231 600 3



Tour Grand Total



INSTRUCTIONS Q1. Create a worksheet given above the doted line.



5 PTS



Q2. Calculate Totals of FEE, ATTENDANCE and COMPUTER SOLD for all months and Grand Total.



10 PTS



Q3. Calculate Performance using IF Condition. 10 PTS IF ATTENDANCE is > 500 then Performance is "EXCELLENT" IF ATTENDANCE is > 300 then Performance is "GOOD" ELSE "POOR" (Paste the If Function as a text at the end of the Sheet) Q4. Calculate following. Average Fee for the month of Jan at the end of the Sheet



5 PTS



Q5. Create a Bar Graph of Cities against Attendance for the month of Feb.



5 PTS



Total Points



35



Tour of London



Accountants Tour of London Name



Asim Nabeel Faisal Nadeem Aijaz Sajjad



Design



Lunch



Director Officer Assistant Director Director Officer



10 0 15 7 12 13



Others



B. Fast



15 12 12 14 5 24



Drinks



17 20 0 9 6 10



13 8 14 13 2 6



Sub Total Grand Total



INSTRUCTIONS Q1. Q2. Q3.



Q4. Q5. Q6. Q8.



Q.9



Create a Worksheet given above the doted line Calculate Average & Total Calculate Remarks using IF Condition IF TOTAL>50 "BAD" IF TOTAL >40 "GOOD" Else "VGOOD" Paste IF Condition as a Text Calculate Sub Totals Calculate Grand Total Calculate Suggestion Calculate Suggestion using IF Condition with Average IF Average > 10 "Please Take Care" "OK Create a Pie Chart of Name & Total Total Points



5pts 5pts 5pts



2pts 3pts 5pts 5pts



5pts



35



£



Avg.



July 20, 2002 to January 15, 2003



Total



Remarks



Suggestion



SHEET 1 USING VLOOKUP FUNCTION Rate Table Limit of Sale Comm% Remarks 1 2 POOR 101 4 BAD 201 6 GOOD 301 8 VGOOD 401 10 EXLT 501 12 EXLT Sales Man KASHIF NADEEM AKBAR FAISAL NABEEL ARIF



Sales



Comm



SHEET 2 DEPRECIATION COMPARISON Description Original Cost Life Year Salvage Value



Remarks



Year



120 12 190 308 450 130



Straight Line SLN 1 2 3 4



INSRUCTIONS Q1



INSTRUCTIONS FOR SHEET1 Create the worksheets given above the doted lines



Q2



Calculate Commission by using VLOOKUP



(The Rate Table is give above)



Q3



Calculate Remarks USING VLOOKUP



(The Rate Table is give above)



Q1



OR Create a column Chart against Salesman and Sales INSTRUCTIONS FOR SHEET2 Create the worksheet given above



Q2



Calculate SLN, DDB and SYD



Q3



Paste all Formulas of Sheet1 and Sheet two as a text at the end of the Sheets. Total Points



SHEET 2



ATION COMPARISON Calculator 1000 4 100



D.Declining Sum of the Balance Year Digits DDB SYD



5 pts 5 pts 5 pts



5 pts 10 pts 5 pts



35



WORLD CUP ONE DAY CRICKET MATCH REPORT TEAM NAME MATCH1 MATCH2 MATCH3 Australia 235 325 345 Bangladesh 120 111 67 Canada 156 201 189 England 234 167 178 India 344 289 290 Pakistan 278 321 322 South Africa 320 278 290 West Indies 221 189 190



TOTAL 905 298 546 579 923 921 888 600



WON



LOST



AVG SCORE



TOTAL



3 0 1 2 3 3 3 2



INSTRUCTIONS Total Time Allowed 25 Minutes Total Marks = 25 Q1 Q2 Q3 Q4 Q5



Q6



Q7 Q8



Design the given sheet (3pts) Calculate LOST Matches by using Formula (3pts) Calculate Average Score by using Excel Function (2pts) Calculate the Total of Two Greatest Values from Three Matches by using Proper Excel Formulas (3pts) Calculate World Ranking by using IF condition (5pts) Tips: IF the Team Won All Three Matches & Average Score is Greater than or Equals to 300, Ranking will be 1st IF the Team Won Only Two Matches & Average Score is Greater than or Equals to 200, Ranking will be 2nd Otherwise Ranking will be 3rd. Calculate Remarks by using IF Condition (2pts) Tips: IF the World Ranking is 3 the team is POOR If the World Ranking is 2 the team is GOOD If the World Ranking is 1 the team is EXLT Create a Pivot Table Report on a new worksheet (4pts) Use Team Names, Won Matches and Average Score for Pivot Table Apply Filter Command "Show EXLT Teams Only" (3pts)



WORLD RANKING REMARKS



SOLUTION G4 ==>  =3F4 H4 ==>  =AVERAGE(B4:D4) I4 ==>  =SUM(B4:D4)MIN(B4:D4) J4 ==>  =IF(AND(F4>2,H4>=300),"1",IF(AND(F4>1,H4>=200),"2","3")) K4 ==>  =IF(J4="3","POOR",IF(J4="2","GOOD","EXLT"))



INSTITUTE OF COST AND MANAGEMENT ACCOUNTANTS OF PA



NAME Zahida Hamid Benson Ali Dawar Yasmin Ali Nomana Badar Ali Chachar Bushra



BASIC SALARY GRADE SEX 3000 17 F 2800 16 M 2500 15 M 4000 19 M 4500 20 M 4500 20 F 4500 20 M 3000 17 F 2800 16 M 3000 17 M 2500 14 M 4000 19 F



LOCATION Gulshan Malir Orangi Landhi Steel Town Korangi Gulbarg F.B. Area Clifton Gulshan Nazimabad F.B. Area



HOUSE RENT



MEDICAL



CONV.



Condition: HOUSE RENT:



Grade>=15, 10% of Basic, Grade>17, 13% of Basic, Grade>19, 20% of Basic of Basic.



MEDICAL:



Grade>=15, 12% of Basic, Grade>17, 15% of Basic, Grade>19, 22% of Basic O of Basic.



CONV.



Grade>=15 and Sex=F and Location is either Korangi, Landhi, Steel Town, 30% Otherwise 20% of Basic, Grade>19, 35% of Basic.



I. TAX:



5% of Basic



STATUS:



Grade>=19, Manager, Grade>=17, Dep. Manager, else Clerk.



______________________________________________________________________________ INSTRUCTIONS: -



Design the Sheet using the above Condition. Develop a Pie Chart between Name and Gross Salary. Paste All Formulas as Text at the very end of this Sheet.



SOLUTION FOR H. RENT FOR MEDICAL



=IF(C6>19,B6*20%,IF(C6>17,B6*13%,IF(C6>=15,B6*10%,B6*8%))) =IF(C6>19,B6*22%,IF(C6>17,B6*15%,IF(C6>=15,B6*12%,B6*10%)))



FOR CONV. I. TAX NET STATUS



=IF(C6>19,B6*35%,IF(AND(C6>=15,D6="F",OR(E6="Korangi",E6="Landhi",E6="Steel Town") =B6*5% =J6-I6 =IF(C6>=19,"MANAGER",IF(C6>=17,"DEP. MANAGER","CLERK"))



COUNTANTS OF PAKISTAN PAYROLL SHEET I. TAX



GROSS



NET



rade>19, 20% of Basic Otherwise 8%



rade>19, 22% of Basic Otherwise 10%



Landhi, Steel Town, 30% of Basic



e Clerk.



___________________________



STATUS



="Landhi",E6="Steel Town")),B6*30%,B6*20%))



National Beverage (Coca Cola) Sale Limit



RATE TABLE Bonus Remarks 1 0 Out 100 0 Bad 200 0 Poor 300 1000 Fair 400 2000 Good 600 5000 Exlt



Emp-Name Amir Nadeem Kashif Aslam Noman Ali Babar Nasir Jalal



Region E W S E S N S E W



Basic 4000 3000 5000 4500 2500 3000 2000 1500 5500



Monthly Sale



Commission



Remarks



567 400 2000 145 256 345 200 100 15



INSTRUCTIONS Q1 Calculate Commission and Remarks using VLOOKUP Function Q2 Calculate Total Commission on Basic Q3 Make a Pivot Table Report and show only Emp-Name, Region and Total Commission



=VLOOKUP(D12,$A$4:$B$9,2) =VLOOKUP(D12,$A$4:$C$9,3) =C12*E12%



TOTAL SALARY



Students Report Summer 2002 Part



TYPE



Total Lectures



Absent



Nasir Khan



F-I



Coaching



80



20



Zubair Baig



F-I



Coaching



80



22



Mustafa Hussain



F-II



Coaching



70



34



Bushra Aziz



F-I



Coaching



80



21



Qasim Nisar



F-II



Correspondence



0



0



Zeshan Ali



F-I



Coaching



80



1



Yayha Khan



F-II



Coaching



70



4



Moeen Ahmer



F-II



Correspondence



0



0



Syed Ali



F-II



Coaching



70



8



Asalm Baig



F-I



Coaching



80



45



M. Naseem



F-I



Coaching



80



3



Nadeem Shah



F-II



Coaching



70



1



Aleem Khan



F-II



Correspondence



0



0



Zahid Ali



F-I



Coaching



80



0



Allowed



Not Allowed



Name



Present



Summary Report Total No. of F-I



Total No. of F-II



INSTRUCTIONS Q1. Type the Above Sheet as given above Q2. Calculate "Present" and "Per% of Attendance" Q3. Calculate Status of Attendance using IF Logical Function: Attendance Per%>=75 "Y" otherwise "N" Q4. Calculate Average of Test1, Test2, Test3 Q5. Calculate Status of Test using IF Logical Function: If the student attended all three tests and got average points >=60, "Y" otherwise "N" Q6. Calculate Status of Presentation Using IF Logical Function: Presentation>1 "Y" otherwise "N" Q7. Calculate Final Status Using IF Logical Function: If the Type of Student =Correspondence, "Allowed" If Status1,Status2,Status3 = "Y", "Allowed" otherwise "Not Allowed" Q8. Calculate Summary Report Using Formulas Q.9 Create a Column Chart of Total No. of F-I, Total No. of F-II, Allowed and Not Allowed



Present Per% Status1 Average Status2 Statu3 Final Status



=D4-E4 =F4/D4*100 =IF(G4>=75,"Y","N") =AVERAGE(I4:K4) =IF(AND(I4>0,J4>0,K4>0,L4>=60),"Y","N") =IF(N4>1,"Y","N") =IF(C4="Correspondence","Allowed",IF(AND(H4="Y",M4="Y",O4="Y"),"Allowed","Not Allowed"))



Help For Summary Report =COUNTIF(B4:B17,"=F-I")



=COUNTIF(B4:B17,"=F-II") =COUNTIF(P4:P17,"=Allowed") =COUNTIF(P4:P17,"=Not Allowed")



s Report



ummer 2002 PER%



Status1



Test1 50



Test2



Test3



88



67



AVG



Status2



Presentation



46



3



79



2



78



67



90



3



90



87



89



2



0



0



0



0



78



56



34



56



78



1



0



0



0



0



33



56



87



3



67



76



65



1



56



53



78



3



78



45



0



0



67



2



3 0



0



76



2



Status3



Final Status



Not Allowed"))
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